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Note pour les utilisateurs Mac
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Windows ou Linux. La table ci-dessous donne quelques équivalents pour les instructions de ce
chapitre. Pour une liste plus détaillée, voyez dans 'Aide.

Windows/Linux Equivalent Mac Effet

Sélection de menu LibreOffice > Préférences Acces aux options de paramétrage
Outils > Options

Clic droit 3 +clic Ouvre un menu contextuel
Ctrl (Contréle) 3 (Commande) Utilisé avec d'autres touches
F5 Maj+38+F5 Ouvre le Navigateur

F11 #E+T Ouvre la fenétre Styles & Formatage
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Introduction

Vous pouvez saisir des données dans Calc de différentes maniéres : en utilisant le clavier, la
souris (glisser et déposer), I'outil Remplir et les listes de sélection. Calc donne également la
possibilité d'entrer de l'information dans plusieurs feuilles d'un méme document en une seule fois.

Vous pouvez formater les données saisies et les afficher de plusieurs facons.

Saisir des données en utilisant le clavier

La plupart des saisies de données dans Calc peuvent étre faites en utilisant le clavier.

Saisir des nombres

Cliquez dans la cellule et tapez le nombre en utilisant les touches numériques soit de la partie
principale du clavier, soit du pavé numérique.

Pour entrer un nombre négatif, tapez le signe moins (=) devant lui ou entourez-le de parenthéses,
comme ceci : (1234).

Par défaut, les nombres sont alignés a droite et les nombres négatifs commencent par le signe
moins.

Saisir des textes
Cliquez dans la cellule et tapez le texte. Les textes sont alignés a gauche par défaut.

Pour saisir un texte de plusieurs lignes dans une cellule, vous pouvez insérer des retours a la ligne
en tapant Ctrl+Entrée.

Vous pouvez agrandir la zone de saisie en cliquant sur I'icone Etendre la barre Formule E]. La

zone de saisie devient alors multi-lignes (Figure 1). Cliguez a nouveau sur l'icone E] pour revenir a
la zone de saisie initiale.

Al =] & & =

N0

m

I B —————

2

2
Figure 1 : Zone de saisie multi-lignes

Saisir des nhombres en tant que textes

Si un nombre est saisi dans le format 01481, Calc supprimera le O devant ce nombre. (Exception :
voir I'Astuce ci-dessous.) Pour conserver le 0 de devant, par exemple pour un numéro de
téléphone, vous pouvez soit :

* assigner le format texte a la cellule (Format > Cellules > Nombres et choisir la catégorie
Texte) et taper ensuite le nombre, comme ceci : 01481.

* taper une apostrophe (guillemet simple) devant le nombre, comme ceci : '01481.
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La donnée est désormais traitée comme un texte et est affichée exactement comme elle a été
saisie. Par conséquent, les formules considéreront cette saisie comme un zéro et les fonctions
l'ignoreront.

Les nombres peuvent commencer par des zéros et étre toujours considérés
comme des nombres (et non comme des textes) si la cellule est formatée de fagon

Astuce appropriée. Faites un clic droit dans la cellule et choisissez Formater les cellules
> Nombres. Ajustez le paramétrage Zéros non significatifs pour ajouter des zéros
au début des nombres.

Quand une apostrophe est utilisée pour permettre I'affichage d'un 0 au début d'un
nombre, elle n'est pas visible dans la cellule dés lors que la touche Entrée est
appuyée. Si des “guillemets intelligents” sont utilisés comme apostrophes,

I'apostrophe restera visible dans la cellule.

aie Pour choisir ce type d'apostrophe, utilisez Outils > Options d'AutoCorrection >

Options linguistiques. Cochez Remplacer les guillemets simples pour activer
cette fonction. La sélection du type de guillemet simple s'appliquera a la fois a
Calc et a Writer.

Attention Quand un nombre est formaté en tant que texte, prenez garde a ce que la cellule
contenant ce nombre ne soit pas utilisée dans une formule, parce que Calc
ignorera sa valeur.

Saisir des dates et des heures

Sélectionnez la cellule et tapez la date ou I'heure. Vous pouvez séparer les éléments de la date
avec un slash (/) ou un tiret () ou utiliser un texte comme 10 octobre 03. Calc reconnait plusieurs
formats de date. Vous pouvez séparer les éléments de temps avec des deux-points comme
10:43:45.

Les formats de dates reconnus par Calc peuvent étre définis dans l'option Motifs d'acceptation de
date dans Outils > Options > Paramétres linguistiques > Langues, avec les notations
suivantes : D pour le jour, M pour le mois et Y pour I'année.

Saisir des caractéres spéciaux

Un caractére “spécial” est un caractére qui ne se trouve pas sur un clavier francais standard. Par
exemple, © % e A 6 g € sont tous des caractéres spéciaux. Pour insérer un caractere spécial :

1) Placez le curseur dans votre document ol vous voulez que le caractére apparaisse.

2) Cliquez sur Insertion > Caractéres spéciaux pour ouvrir la boite de dialogue Caractéres
spéciaux (Figure 2).

3) Sélectionnez un ou plusieurs caractéeres (depuis une police ou un sous-ensemble de
polices) que vous voulez insérer ; puis cliguez sur OK. Les caracteres sélectionnés sont
affichés en bas a gauche de la boite de dialogue. Quand vous sélectionnez un caractere, il
est affiché seul en bas a droite, avec son code numérique associé.

Les différentes polices comprennent des caractéres spéciaux différents. Si vous
Note ne trouvez pas le caractére spécial particulier que vous voulez, essayez de
changer la sélection de Police.
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Caractéres spéciaux @
Police Times New Roman E Sous-ensemble .Grec E| [ QK l
- _ = = 1 a a e d k - r t v x ’ - I Annuler l
o Talelal; ~ A E|H|T|0o|Y|®Q T
i|lA/IB|T|IA|E|Z|H|O|I|K|A|M|N|=Z|O -
nlelz|(T|y|e|x|e|ao|li|v|alelq|ils | Supprimer |
a |[p|y]|d n Eln|O|v|x|A|pn|v|&|lo|m
plel|lo|t|v|o|yx|v]|@|i|b|o|v|w|B|d
A RYRS o|%|[Q|e[C]¢ Fl=o|5 D]
Wlw|9|9|b|2|2|2|X|x|0|es|T|t|x]e -

Figure 2 : Boite de dialogue Caractéres spéciaux

Insérer des tirets

Pour saisir des tirets moyens et longs, vous pouvez utiliser l'option Remplacer les tirets dans
l'onglet Outils > Options d'AutoCorrection > Options. Cette option remplace deux traits d'union,
sous certaines conditions, par le tiret correspondant.

Dans la table suivante, A et B représentent un texte constitué de lettres de A a z et de chiffres de 0
ao.

Texte que vous tapez : Résultat

A - B (A, espace, moins, espace, B) A—B (A, espace, tiret moyen, espace, B)
A -- B (A, espace, moins, moins, espace, B) A—B (A, espace, tiret moyen, espace, B)
A--B (A, moins, moins, B) A—-B (A, tiret long, B)

A-B (A, moins, B) A-B (sans modification)

A -B (A, espace, moins, B) A -B (sans modification)

A --B (A, espace, moins, moins, B) A-B (A, espace, tiret moyen, B)

Désactiver les changements automatiques

Calc applique automatiquement plusieurs changements durant la saisie de données, a moins que
vous n'ayez désactivé ces changements. Vous pouvez également annuler immédiatement chaque
changement automatique avec Ctrl+Z.

Changements de I'AutoCorrection
La correction automatique des erreurs de frappe, le remplacement des guillemets doubles
droits par des apostrophes courbes et le début de contenu de cellule avec une lettre majuscule
sont contrblés par Outils > Options d'AutoCorrection. Allez dans les onglets Options ou
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Remplacer pour désactiver chaque caractéristique indésirable. Dans I'onglet Remplacer, vous
pouvez également supprimer les paires de mots non souhaitées et ajouter de nouvelles paires.

AutoSaisie
Quand vous tapez du texte dans une cellule, Calc suggére automatiquement une occurrence
trouvée dans la méme colonne. Pour activer ou désactiver I'AutoSaisie, affichez ou enlevez
une coche devant Outils > Contenu des cellules > AutoSaisie.

Conversion automatique des dates
Calc convertit automatiquement certaines saisies en dates. Pour s'assurer qu'une saisie qui
ressemble a une date soit considérée comme un texte, formatez la cellule en texte ou tapez
une apostrophe au début de la saisie.

Accélérer la saisie des données

La saisie de données dans un classeur peut demander beaucoup de travail, mais Calc fournit
plusieurs outils pour alléger certaines corvées de saisie.

La fonctionnalité la plus simple est de faire glisser et déposer le contenu d'une cellule dans une
autre avec la souris. Beaucoup de personnes trouvent également utile I'AutoSaisie. Calc recele
également plusieurs autres outils pour la saisie automatique, plus particuliérement pour les taches
répétitives. Ce sont I'outil Remplir, les listes de sélection et la possibilité de saisir de l'information
dans plusieurs feuilles du document.

Utiliser I'outil Remplir dans les cellules

Au plus simple, I'outil Remplir est une fagon de dupliquer un contenu existant. Commencez par
sélectionner la cellule a copier, puis faites glisser la souris dans une direction (ou gardez appuyée
la touche Maj et cliquez dans la derniére cellule que vous voulez remplir), et choisissez ensuite
Edition > Remplir et la direction dans laquelle vous voulez effectuer la copie : Haut, Bas, Gauche
ou Droite.

Oiriginal Driginal

11
12
Figure 3 : Utiliser I'outil Remplir
Attention Les choix qui ne sont pas valables sont grisés, mais vous pouvez toujours choisir

A\ la direction opposée a celle que vous souhaitez, ce qui peut avoir comme
conséquence d'écraser accidentellement des cellules.

8 Saisir, Modifier et Formater des Données



Une maniere rapide de remplir des cellules est de saisir la “poignée” dans le coin
inférieur droit de la cellule et de la faire glisser dans la direction que vous voulez
remplir. Si la cellule contient un nombre, alors des nombres rempliront les cellules
selon une série. De méme, si la cellule contient un texte, ce méme texte remplira
les cellules dans la direction que vous choisirez.

Astuce

Utiliser une série de remplissage

Une utilisation plus complexe de I'outil Remplir est d'utiliser une série de remplissage. Des listes
par défaut existent pour les jours de la semaine, complets et abrégés, et les mois de I'année, mais
Vvous pouvez également créer vos propres listes.

Pour ajouter une série de remplissage a un classeur, sélectionnez les cellules a remplir, choisissez
Edition > Remplir > Série. Dans la boite de dialogue Remplir la série, sélectionnez Remplissage
automatique comme Type de séries et entrez comme Valeur initiale un élément d'une série
définie. Les cellules sélectionnées se rempliront alors en séquence avec les autres éléments de la
liste, en se répétant depuis le début de la liste si la fin de la liste est atteinte.

Remplir |a série 5]
Directicn Type de séries Unité de temps [ oK l
@ En bas Linéaire lou
A droite Géométrigque Jour de la zemaine | Annuler |
En haut Dat Aois :
n hau Date Mo | Aide |
A gauche @ Remplissage automatig Année

janwvier

novembre

décembre

Figure 5 : Résultat de la sélection de la série de
remplissage telle que Figure 4
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Vous pouvez également utiliser Edition > Remplir > Série pour créer une série de remplissage
occasionnelle pour des nombres en saisissant les valeurs de début et de fin et I'incrément. Par
exemple, si vous saisissez les valeurs de début et de fin de 1 et 7 avec un incrément de 2, vous
obtiendrez la séquence 1, 3, 5, 7.

Dans tous les cas, I'outil Remplir crée seulement une liaison momentanée entre les cellules. Une
fois qu'elles sont remplies, les cellules n'ont plus de liaison entre elles.

Définir une série de remplissage

Pour définir votre propre série de remplissage, allez & Outils > Options > LibreOffice Calc >
Listes de tri. Cette boite de dialogue affiche les séries précédemment définies dans le champ
Listes sur la gauche, et le contenu de la liste en surbrillance dans le champ Entrées.

Listes Entrées
lun.,mar., mer., jeu.,ven.,sam.,dim. lun. - | MNouveau |
lundi,rardi, mercredi,jeudi vendred| | mar.
janv. févr, mars,avr, mai juin juil, ac| | Mer -
Janvier,février, mars,avril, maijuin jui| | JE4 pad i
wen.
=am. | Supprimer |
dirn.
Al
Copier la liste depuis SFeuillel 5451 Copier

Figure 6 : Séries de remplissage prédéfinies

Cliquez sur Nouveau. Le champ Entrées est mis a blanc. Tapez les valeurs de la nouvelle liste
dans le champ Entrées (une entrée par ligne), et cliquez ensuite sur Ajouter.

Listes Entrées
L dim Ain ~ | Ignorer |
un ndre Aisne
an uin, juil, ac Allier .
an iiviriuil | Alpes-de-Haute-Provence | Ajouter |

Hautes-Alpes
Alpes-Maritimes
Ardeche
Ardennes

(=]
=]
T

LA

Figure 7 : Définir une nouvelle série de remplissage

Vous pouvez également définir une série de remplissage a partir d'une plage de cellules. Pour
ceci, sélectionnez la plage de cellules qui contient les valeurs de la série, allez a Outils > Options
> LibreOffice Calc > Listes de tri et cliguez sur Copier. Si la plage comporte plus d'une ligne et
plus d'une colonne, la boite de dialogue Copier la liste s'ouvre, vous demandant d'indiquer si la
série se trouve en ligne ou en colonne.
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Utiliser les listes de sélection 12 |Nancy

. e . . : 13
Les listes de sélection sont disponibles uniquement pour les textes et sont :u_l

limitées a l'usage de textes qui ont été déja saisis dans la méme colonne.

15 |Bordeaux =

Pour utiliser une liste de sélection, sélectionnez une cellule vide et appuyez 16 |Brest

sur Alt+! (fleche bas) (versions précédentes : Ctrl+D ou Ctrl+Maj+D), ou 17 |Lille

faites un clic droit et choisissez Liste de sélection. Une liste déroulante 18 |Lyen

apparait, contenant toutes les cellules de la méme colonne qui ont au moins 19 |Marseille | _
un caractére de texte ou dont le format est défini comme texte. Les textes 2p |Montpellier

des cellules sont triés par ordre alphabétique et ceux qui ont des n m?ncy
occurrences multiples n'apparaissent qu'une seule fois. Cliquez sur l'entrée 22 F'aI:ii
dont vous avez besoin. =R
—|RENNES
2 St-Etienne -
: 2 |
Fusionner des cellules 2

Vous pouvez sélectionner des cellules adjacentes et les fusionner en une seule. Pour ceci, vous
pouvez sélectionner les cellules désirées et :

¢ Sélectionner Format > Fusionner les cellules > Fusionner les cellules dans la barre de
menus.
¢ Faire un clic droit et choisir Fusionner les cellules dans le menu contextuel.

Si une des cellules autre que la premiére est remplie, un message s'affiche, vous proposant de
déplacer le contenu des cellules cachées dans la premiére cellule. Vous pouvez accepter (le
contenu des cellules est concaténé avec un espace de séparation), refuser (le contenu des
cellules autres que la premiére est masqué) ou annuler I'opération.

Vous pouvez également sélectionner Format > Fusionner les cellules > Fusionner et centrer
les cellules dans la barre de menus, ou cliquer sur le bouton Fusionner et centrer les cellules

F= de la barre d'outils Formatage, pour fusionner les cellules et centrer le contenu résultant.

Pour annuler la fusion de cellules, sélectionnez la cellule fusionnée et choisissez Format >
Fusionner les cellules > Scinder les cellules dans la barre de menus ou cliquez sur le bouton

Fusionner et centrer les cellules de la barre d'outils Formatage [ .

Partager du contenu entre différentes feuilles

Vous pouvez vouloir entrer la méme information dans la méme cellule de plusieurs feuilles, par
exemple pour fixer des listes standard pour un groupe de personnes ou pour des organismes. Au
lieu de saisir la liste individuellement dans chaque feuille, vous pouvez la saisir en une fois pour
toutes les feuilles. Pour ce faire, sélectionnez les feuilles désirées (Edition > Feuille >
Sélectionner et cliqguez sur le nom des feuilles désirées en maintenant la touche Ctrl enfoncée),
puis saisissez l'information dans la feuille courante.

Attention Cette tech.nique écrase toute inf(_)rmation qui se trouve d_éjé\ dans les cellules de_s _
autres feuilles, sans aucun avertissement. Pour cette raison, quand vous avez fini,
A assurez-vous de bien dé-sélectionner toutes les feuilles sauf celle que vous voulez
maodifier. (Ctrl+clic sur un onglet pour sélectionner ou dé-sélectionner la feuille.)

Partager du contenu entre différentes feuilles 11



Valider le contenu des cellules

Quand vous créez des classeurs pour que d'autres personnes les utilisent, vous pouvez vouloir
vous assurer qu'elles saisissent des données qui sont valides ou appropriées pour la cellule. Vous
pouvez également utiliser la validation pour votre propre usage comme guide pour saisir des
données complexes ou rarement utilisées.

Les séries de remplissage et les listes de sélection peuvent convenir pour certains types de
données, mais elles sont limitées aux informations pré-définies. Pour valider une nouvelle donnée
saisie par un utilisateur, sélectionnez une cellule et utilisez Données > Validité pour définir le type
de contenu qui peut étre saisi dans cette cellule. Par exemple, une cellule peut nécessiter une date
ou un nombre entier, sans caractére alphabétique ni point décimal ; ou bien encore une cellule ne
doit pas étre laissée vide.

Selon le paramétrage de la validation, I'outil peut aussi définir I'intervalle des valeurs qui peuvent
étre saisies, et fournir des messages d'aide qui expliquent les régles de validation que vous avez
paramétrées pour cette cellule (ce que les utilisateurs devraient faire s'ils saisissent un contenu
incorrect). Vous pouvez aussi paramétrer la cellule pour refuser un contenu incorrect, l'accepter
avec un avertissement, ou, si vous étes trés organisé, exécuter une macro si une erreur est saisie.

Bien que leur contenu soit obtenu par calcul, vous pouvez définir une validation pour les cellules
qui contiennent des fonctions. Le contréle de validité ne se déclenchera pas lors du calcul mais
vous pouvez utiliser Outils > Audit > Marquer les données incorrectes pour trouver les cellules
avec des données incorrectes. La fonction Audit marque chaque cellule contenant des données
incorrectes avec un ovale.

4
Figure 8 : Données incorrectes marquées par la fonction Audit

Notez qu'une regle de validité est considérée comme une partie du format de la cellule. Si vous
sélectionnez Formats ou Tout supprimer depuis la boite de dialogue Supprimer du contenu, alors
elle sera supprimée (si la commande de I'Audit Marquer les données incorrectes est a nouveau
effectuée, les ovales des données incorrectes disparaitront, parce que la donnée n'est désormais
plus incorrecte). Si vous voulez copier une régle de validité avec le reste de la cellule, utilisez
Edition > Collage spécial > Formats ou Tout insérer.
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La Figure 9 montre les choix possibles pour un test de validité ordinaire. Notez I'option Autoriser
les cellules vides sous la liste déroulante Autoriser.

Validité ==

Critéres |Aideé la saisielMessage d'erreur|

Autariser |Décima| IE”

Sutorizer les cellules vides

Donnges

Valeur inférieur &
superieur 3
inférieur ou égal 3
supérieur cu égal 3
différent

entre

non cempris entre

Figure 9 : Choix d'un test de validité ordinaire

Les options d'un test de validité peuvent changer selon le type de données sélectionné dans la
liste Autoriser. Par exemple, la Figure 10 montre les choix quand une cellule doit contenir une
plage de cellules.

Validité [=5]

Critéres |Aideé la 5ai5ie| Message d'erreur |

Autoriser Plage de cellules =

Autorizer les cellules vides
Afficher la liste de sélection

[] Trier les entrées dans I'ordre croissant

Source

Une source valide est constituée d'une sélection contigué de lignes
et de colonnes, ou d'une formule dont le résultat est une zone ou
une rmatrice.

Figure 10 : Choix de validité pour une plage de cellules

Pour fournir une aide a la saisie pour une cellule, utilisez lI'onglet Aide a la saisie de la boite de
dialogue Validité (Figure 11). Pour afficher un message d'erreur quand une valeur incorrecte est
saisie, utilisez l'onglet Message d'erreur (Figure 12). Essayez d'écrire une remarque pertinente,
expliqguant ce qu'une saisie valide devrait contenir, et pas simplement “Données incorrectes.
Réessayez” ou quelgue chose de ce genre.
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Validité ==

| Critéres |ﬂidE a la saisie | Message d'erreur

;gﬂ:icher I'aide & la saisie lors de la sélection d'une cellule

Contenu

Titre

Aide 3 13 =aisie -

Figure 11 : Définir une aide a la saisie pour une cellule

Validité ==

|Critéres |Aideé la saisielMessaged'erreur

Afficher un message d'erreur en cas de saisie de valeurs incorrectes

Contenu
Action Parcourir...
Titre Hfovertissermnent
Information
Message d'erreur Macro o

Figure 12 : Définir un message d'erreur pour une cellule avec une donnée incorrecte

Modifier les données

La modification des données se fait en gros de la méme maniére que leur saisie. La premiére
étape est de sélectionner la cellule contenant les données a modifier.

Supprimer les données d'une cellule
Les données d'une cellule peuvent étre effacées (supprimées) de plusieurs fagons.

Supprimer les données seulement
Les données seules peuvent étre supprimées dans une cellule sans affecter le formatage de la
cellule. Cliquez dans la cellule pour la sélectionner et appuyez ensuite sur la touche Suppr.

Supprimer les données et le formatage
Les données et le formatage peuvent étre supprimés d'une cellule en une seule fois. Appuyez
sur la touche Retour arriere (ou faites un clic droit et choisissez Supprimer du contenu, ou
utilisez Edition > Supprimer du contenu) pour ouvrir la boite de dialogue Supprimer du
contenu (Figure 13). Dans cette boite de dialogue, plusieurs attributs de la cellule peuvent étre
supprimés. Pour tout supprimer dans une cellule (contenu et format), cochez Tout supprimer.
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Supprimer du contenu @

Sélection [

oK |

......................................

| Annuler |

Mombres | Aide |

Date & heure
Formules
Commentaires
Formats

Objets

Figure 13 : Boite de dialogue Supprimer du
contenu

Si vous choisissez Héritage OpenOffice.org comme Raccourci clavier dans I'option
Note Outils > Options > LibreOffice Calc > Compatibilité, le comportement des
touches Suppr et Retour arriére est inverseé.

Remplacer toutes les données dans une cellule

Pour supprimer les données et insérer de nouvelles données, tapez simplement par-dessus les
anciennes données. Les nouvelles données conserveront le format d'origine.

Changer une partie des données dans une cellule

Il est parfois nécessaire de changer le contenu d'une cellule sans en supprimer tout le contenu,
par exemple quand la phrase “Jean va partir” se trouve dans une cellule et doit étre changée en
“Jean va partir demain.” Il est souvent utile de le faire sans tout d'abord supprimer I'ancien contenu
de la cellule.

La méthode est similaire a celle décrite ci-dessus, mais vous devez placer le curseur dans la
cellule. Vous pouvez le faire de deux manieres.

Utiliser le clavier
Apres avoir sélectionné la cellule désirée, appuyez sur la touche F2 et le curseur sera placé a
la fin de la cellule. Utilisez alors les fleches du clavier pour déplacer le curseur dans le texte de
la cellule.

Utiliser la souris
Double-cliquez dans la cellule voulue (pour la sélectionner et placer le curseur a l'intérieur pour
modification), ou cliquez pour sélectionner la cellule et ensuite déplacez le pointeur de la souris
dans la ligne de saisie et cliquez a l'intérieur pour placer le curseur pour modification.

Collage spécial dans une cellule

Vous pouvez utiliser la fonction de collage spécial pour ne recopier dans une cellule qu'une partie
d'une cellule d'origine, son format ou le résultat brut de sa formule par exemple. Pour ceci, vous
devez copier une cellule ou une plage dans le presse-papiers. Ensuite, vous pouvez sélectionner
la cellule ou la plage de destination et :

e Sélectionner Edition > Collage spécial depuis la barre de menus
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* Appuyer sur Ctrl+Maj+V
* Faire un clic droit et sélectionner Collage spécial dans le menu contextuel

La boite de dialogue Collage spécial apparait.

Collage spécial @
Sélection Opérations
[ OK |
il @ Aucune
Texte Addition | Sanules |
Mormbres Soustraire | Aide |
Date & heure Multiplication
Formules Division
Opticns Déplacer les cellules
Ignorer les cellules vides @ Me pas déplacer
Transposer Vers le bas
Lier Vers la droite

Figure 14 : Boite de dialogue Collage spécial

Si vous conservez les options par défaut, le collage spécial équivaut a un collage normal. Vous
pouvez décocher I'option Tout insérer et choisir les éléments pour ne recopier qu'une partie de la
cellule d'origine.

Au lieu d'écraser le contenu d'une cellule, vous pouvez effectuer une des quatre opérations
arithmétiques entre les contenus des cellules d'origine et de destination.

Vous pouvez insérer les cellules d'origine et déplacer les cellules de destination vers le bas ou
vers la droite.

Il existe des commandes simplifiées de collage spécial dans le menu contextuel d'une cellule. Pour
ceci, faites un clic droit et choisissez Coller seulement > Texte, Nombre ou Formule.

Insérer un champ dans une cellule

Vous pouvez insérer dans une cellule un champ correspondant a la date du jour, au nom de la
feuille ou au nom du document. La cellule doit étre en cours de modification. Pour ceci, placez le
curseur dans la cellule comme décrit dans le sujet Changer une partie des données dans une
cellule. Faites alors un clic droit, puis, dans le menu contextuel, choisissez Insérer des champs >
Date ou Nom de feuille ou Titre.

Attention . i o
j La commande Insérer des champs > Titre va insérer dans la cellule le nom du

fichier et non pas le titre du document défini dans ses propriétés.
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Formater les données

Les données dans Calc peuvent étre formatées de plusieurs facons. Le formatage peut soit faire
partie d'un style de cellules qui sera appliqgué automatiquement, soit étre appliqué manuellement a
la cellule. Certains formatages manuels peuvent étre appliqués en utilisant les icénes de barre
d'outils. Pour plus de contr6les et d'options supplémentaires, sélectionnez la cellule ou la plage de
cellules voulue, faites un clic droit a l'intérieur et sélectionnez Formater les Cellules. Toutes les
possibilités de formatage sont abordées ci-dessous.

Tous les paramétrages abordés dans cette section peuvent aussi étre effectués en
Note tant qu'éléments d'un style de cellule. Voir Chapitre 4 (Utiliser les styles et les
modeles) pour plus d'informations.

Formater plusieurs lignes de texte

Des lignes de texte multiples peuvent étre saisies dans une seule cellule en utilisant le renvoi a la
ligne automatique ou des retours a la ligne manuels. Chaque méthode est utile dans différentes
situations.

Utiliser le retour a la ligne automatique

Pour que le texte revienne a la ligne en fin de cellule, faites un clic droit et sélectionnez Formater

les cellules (ou choisissez Format > Cellules depuis la barre de menus, ou appuyez sur Ctri+1).

Dans l'onglet Alignement (Figure 16), sous Propriétés, cochez Renvoi a la ligne automatique. Le
résultat est montré ci-dessous (Figure 15).

Cette cellule est paramétrée pour ne pas avoir de renvoi a [a ligne automatique. Le texte continue ...
Cette cellule est paramétrée avec un

renvoi A la ligne automatique. La cellule

contient un texte important sans devenir

plus large.

Figure 15 : Retour a la ligne automatique
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Formater les cellules ==

|N0mbres|Police|Eﬁets de caractéres|ﬂ|igﬂemer1t |Bcrrdureslﬂ.rriére-plan Protection de r_ellulel

Alignement du texte

Haorizontal Retrait Vertical
|Par|:|éfaut |Z|| Ipt : |Par|:|éfaut |E||

Orientation du texte

| Degrés [C] Empilé verticalement
4 L )r/ —
. - ] S
— ABCD =
T - Bord de référence
- ..

’ffxu‘*\ E’IZI

Propriétes

[V Renvai 3 Ta ligne autormatiquel

[ Coupure des mots active

AJUSTEr 3 1a Tallle de la cellule

Figure 16 : Boite de dialogue Formater les cellules > Alignement

Utiliser les sauts de ligne manuels

Pour insérer un saut de ligne manuel pendant la frappe dans une cellule, appuyez sur Ctrl+Entrée.
Pour modifier un texte, double-cliquez d'abord dans la cellule, puis cliquez a I'endroit ou vous
voulez faire un saut de ligne.

Quelle que soit la méthode (renvoi a la ligne automatique ou saut de ligne manuel), la hauteur de
ligne est adaptée mais la largeur de cellule ne change pas. La Figure 17 montre le résultat de la
saisie de deux sauts de ligne manuels aprés la premiére ligne de texte.

Cette ligne contient des sauts de ligne manuels.

Les lignes peuvent &tre espacées de cette fagon.
Et la largeur de cellule n'est pas modifice.

Figure 17 : Cellule avec sauts de ligne manuels

Ajuster le texte a la taille de la cellule

La taille de police des données d'une cellule peut étre automatiquement ajustée pour remplir la
cellule. Pour le faire, cochez I'option Ajuster a la taille de la cellule dans la boite de dialogue
Formater les cellules (Figure 16). La Figure 18 montre le résultat.

La taille de police s'ajuste 313 cellule | izmeoepoics 5ot 212 02002 |y e oo mosen e i n cmie

Figure 18 : Ajustement de la taille de police a la cellule
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Formater les nombres

Plusieurs formats de nombres différents peuvent étre appliqués aux cellules en utilisant les icones
de la barre d'outils Formatage. Sélectionnez la cellule, puis cliquez sur l'icbne correspondante.
Certaines icdnes peuvent ne pas étre visibles avec le réglage par défaut ; faites un clic droit sur la
barre puis choisir Boutons visibles et sélectionnez les icones a afficher.

J % [0 e B2 00 %

Figure 19 : Icénes de formats de nombres. De gauche a droite : monnaie, pourcentage,
date, scientifique, standard, ajouter une décimale, supprimer une décimale

Depuis Calc 3.3, les nombres formatés avec le format de nombre Standard sont affichés avec
autant de décimales que nécessaire. Avec les versions plus anciennes de Calc, un maximum de 2
décimales était affiché avec ce format. Vous pouvez reproduire ce mode de fonctionnement en
sélectionnant Outils > Options > LibreOffice Calc > Calcul et en choisissant Limiter les
décimales pour le format de nombre général.

Pour plus de contrble ou pour sélectionner d'autres formats de nombres, utilisez I'onglet Nombres
(Figure 20) de la boite de dialogue Formater les cellules :

* Appliquez I'un des types de données de la liste Catégorie aux données.
* Contrblez le nombre de décimales et de zéros non significatifs.
* Saisissez une description de format personnalisée.

Le paramétre Langue détermine les paramétres locaux pour les différents formats comme l'ordre
dans les dates et le symbole de 'unité monétaire.

Formater les cellules [£5]
Mombres |Pu|ir_e|E1‘fets de caractéres Alignement|Bordures|ﬁkrriére-plan |F‘rnter_tiur1 de r_ellulel
Catégorie Format Langue
e —
m » Standard |F'ar défaut - Frangais I{FrarIE"
Pourcentage -1234
Meonnaie -1234.12
Date -1234
Heure E -123412
Scientifique -123412
Fraction
Valeur logique - 123457
Opticns
Décimales 2 = | Mombres négatifs en rouge
Zeros non significatifs 1 = | Separateur de milliers;
Description de format
# #20,00;[RED]-# £20,00 o || 2
Defini par I'utilisateur

Figure 20 : Formater les cellules > Nombres
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Formater la police

Pour choisir rapidement la police utilisée dans une cellule, sélectionnez la cellule, puis cliquez sur
la fleche prés du champ Nom de police dans la barre d'outils Formatage et choisissez une police
dans la liste.

Pour choisir d'afficher les noms de police dans leur police ou en texte simple, allez
dans Outils > Options > LibreOffice > Affichage et cochez ou décochez
Afficher I'apercu des polices dans la section Liste des polices. Pour plus
d'informations, voir Chapitre 14 (Paramétrer et personnaliser Calc).

Astuce

Pour choisir la taille de la police, cliquez sur la fleche prés du champ
Taille de police dans la barre d'outils Formatage. Pour d'autres A -

formats, vous pouvez utiliser les icones Gras, ltalique ou Soulignage. =

.. . . . . + Couleur de police
Pour choisir une couleur de police, cliquez sur la fleche prés de

I'icbne Couleur de police pour afficher la palette des couleurs. [Automatigue ||
Cliquez sur la couleur voulue. -.=..==..-
Pour définir des couleurs personnalisées, utilisez Outils > Options > 11
LibreOffice > Couleurs. Voir Chapitre 14 pour plus d'informations. EEEEEEEE
Pour spécifier la langue de la cellule (utile pour permettre & plusieurs Il B0 B0 I I
langues d'exister dans un méme document et d'étre vérifiées EEEEREEREN
correctement (orthographe)), utilisez I'onglet Police de la boite de EEREEN
dialogue Formater les cellules. Voir Chapitre 4 pour plus HERERT N
d'informations. N

EEEEREEN

n HER
HEEE.
[ ]

Automatique

Choisir les effets de caractéeres

L'onglet Effets de caractéres (Figure 21) de la boite de dialogue Formater les cellules offre plus
d'options concernant la police.

Surlignhage et soulignage
Vous pouvez choisir parmi plusieurs sortes de surlignage et de soulignage (lignes continues,
pointillés, tirets courts et longs, dans de multiples combinaisons) et la couleur de la ligne.

Barré
Vous pouvez barrer le contenu avec des lignes, des slash et des X.

Relief
Les possibilités de relief sont : relief (texte surélevé), empreinte (texte enfoncé), contour et
ombre.
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Mombres | Police | Effets de caractéres | Alignement I Bordures | Arriére-plan

Couleur de police Surlignage Couleur de surlignage
||:| Automatique |Z|| |{San5:| IE” ||:| Autornatique
Barré
|I{San5:| |E||
Relief Soulignage Couleur de sgulignage
||:Sar15] |z|| |I{San5:| |z|| ||:| Automatigue
[ Contour Mot par ot
[] Ombre

Figure 21 : Formater les cellules > Effets de caractéres

Paramétrer lI'alignement et I'orientation des cellules

Certaines des icones d'alignement et d'orientation des cellules ne sont pas affichées par défaut
dans la barre d'outils Formatage. Pour les afficher, faites un clic droit sur la barre puis choisir
Boutons visibles et sélectionnez les icones a afficher.

' Aligner & gauche

Aligner au centre horizontalement
Aligner a droite

Justifié

Fusionner et centrer les cellules

De gauche a droite

& i

De droite 3 gauche

T
1

Orientation du texte de gauche a droite

|l

—
-y
o

Crientation du texte de haut en bas

(1]
—

Aligner en haut

[
hmd

Aligner au centre verticalement

=1 Aligner en bas

Figure 22 : Alignement et orientation des
cellules

Certaines des icones d'alignement et d'orientation ne sont accessibles que si vous avez activé les
langues asiatiques ou les scripts complexes (dans Outils > Options > Parameétres linguistiques

> Langues). Si vous choisissez dans la liste une icbne non disponible, elle n'apparaitra pas dans
la barre d'outils.

Pour plus de contrble et de choix, utilisez I'onglet Alignement (Figure 16) de la boite de dialogue

Formater les cellules pour déterminer I'alignement horizontal et vertical et donner une rotation au
texte.
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Si vous avez activé les langues asiatiques, la section Orientation du texte comporte alors une case
a cocher supplémentaire (Mode de mise en page asiatique) sous la case Empilé verticalement,
comme Figure 23.

| Ernpilé verticalement

| Mode de mise en page asiatique

Figure 23 : Options d'affichage des langues asiatiques

La différence de résultat entre Mode de mise en page asiatique coché ou non est montrée Figure
24.

Si vous avez activé les langues asiatiques, I'onglet Typographie asiatique est ajouté dans la boite
de dialogue. Cet onglet permet d'appliquer la liste des caractéres interdits en début et en fin de
ligne.

=

W a

o )

d i}

e )
=
=

a [1=]
P2

5 a

[ =

a

t

i

q

]

e

n

]

n

C

]

C

h

é

Figure 24 : Types
d'empilements verticaux

Formater les bordures des cellules

Pour choisir rapidement un style de ligne et une couleur pour les bordures d'une cellule, cliquez
sur la petite fleche pres des icones Style de lignhe et Couleur de ligne dans la barre d'outils
Formatage. Si les icones Style de ligne et Couleur de ligne ne sont pas affichées dans la barre
d'outils Formatage, faites un clic droit sur la barre puis choisir Boutons visibles et sélectionnez
les icbnes & afficher. Dans chaque cas, une palette de choix est affichée.

Pour plus de contrble, comme I'espacement entre les bordures de la cellule et le texte, utilisez
l'onglet Bordures de la boite de dialogue Formater les cellules. La, vous pouvez également définir
un style d'ombre. Voir Chapitre 4 pour plus de détails.
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Les propriétés de bordure de cellule s'appliquent a une cellule, et ne peuvent étre
modifiées que dans cette cellule. Par exemple, si la cellule C3 a une bordure

Note haute (ce qui est visuellement équivalent a une bordure basse dans C2), cette
bordure ne pourra étre supprimée qu'en sélectionnant C3. Elle ne pourra pas étre
supprimée dans C2.

Formater l'arriére-plan des cellules

Pour choisir rapidement une couleur d'arriére-plan pour une cellule, cliquez sur la petite fleche
pres de l'icdbne Couleur d'arriére-plan dans la barre d'outils Formatage. Une palette de choix de
couleurs, identique a la palette Couleur de police, est affichée.

Pour définir des couleurs personnalisées, utilisez Outils > Options > LibreOffice > Couleurs.
Voir Chapitre 14 pour plus d'informations.

Vous pouvez également utiliser I'onglet Arriere-plan de la boite de dialogue Formater les cellules.
Voir Chapitre 4 pour plus de détails.

Mise en évidence des valeurs

Cette fonction affiche le contenu des cellules avec des couleurs différentes selon le type de
données.

Sélectionnez Affichage > Mise en évidence des valeurs depuis la barre de menus, ou appuyez
sur Ctrl+F8, pour activer ou désactiver cette fonction.

Les cellules de texte sont formatées en noir, les nombres en bleu et les formules en vert, quel que
soit le formatage de cellule qui a été défini. Si cette fonction est active, les couleurs que vous avez
définies pour le document ne seront pas affichées. Lorsque vous désactivez cette fonction, les
couleurs définies par les utilisateurs réapparaissent.

Cette fonction peut également étre activée en sélectionnant Outils > Options > LibreOffice Calc
> Affichage et en cochant 'option Mise en évidence des valeurs. Cette action va appliquer la mise
en évidence des valeurs a chaque fois que vous ouvrirez Calc, ce qui n'est peut-étre pas ce que
vous souhaitez.

Si vous avez sélectionné Affichage > Mise en évidence des valeurs, lors d'une

Attention impression ou d'un apercu avant impression, la fonctionnalité est désactivée et les
couleurs du formatage sont utilisées. Ce n'est pas le cas si vous avez utilisé
A I'option Mise en évidence des valeurs de Outils > Options > LibreOffice Calc >
Affichage.

Auto-formatage des cellules et des feuilles

Vous pouvez utiliser la fonctionnalité AutoFormat pour appliquer rapidement un ensemble de
formats de cellules a une feuille ou une plage de cellule sélectionnée.

1) Sélectionnez les cellules que vous voulez formater, avec les en-tétes de colonnes et de
lignes.

2) Choisissez Format > AutoFormat.

3) Sélectionnez le format souhaité dans la liste.

4) Pour sélectionner quelles propriétés (format de nombres, police, alignement, bordures,
motif, ajustement de la largeur et de la hauteur) sont a inclure dans un AutoFormat, cliquez
sur Plus. Cochez ou décochez les options voulues. Cliquez sur OK.
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AutoFormat @

Format |

Par défaut

ab

Bleu

Gris

Jaune
Lavande
Marron
Monnaie
Meonnaie 30
Monnaie grise
Monnaie lavande

EAdrnmaic furmsianics

oK |

Janv. Fewr. Mars Somme | Annuler |

F

Mord 3 | Aide |

Milieu -
| Ajouter... |

Formatage -
I

L=
| Format numérique | Police | Alignement

| Bordures | Motif | Ajuster la largeur/hauteur

Figure 25 : Choisir un AutoFormat

Si vous ne voyez pas de changement de couleur du contenu des cellules, vérifiez si Affichage >
Mise en évidence des valeurs n'est pas coché.

Si la plage de cellules ne contient pas au moins 3 x 3 cellules, AutoFormat n'est

Note pas disponible.

Définir un nouvel AutoFormat

Vous pouvez définir un nouvel AutoFormat disponible pour tous les classeurs.
1) Formatez une feuille.

2) Sélectionnez la plage de données définissant le nouvel AutoFormat, d'une dimension
minimum de 4 x 4 cellules, ou choisissez Edition > Tout sélectionner.

3) Choisissez Format > AutoFormat. Le bouton Ajouter est maintenant actif.
4) Cliquez sur Ajouter.

5) Dans le champ Nom de la boite de dialogue Ajouter un AutoFormat, tapez un nom
significatif pour le nouveau format.

6) Cliquez sur OK pour enregistrer. Le nouveau format est désormais valable dans la liste
Format de la boite de dialogue AutoFormat.

Formater les classeurs en utilisant les thémes

Calc est fourni avec un ensemble pré-défini de thémes de formatage que vous pouvez appliquer a
vos classeurs.

Il n'est pas possible d'ajouter des thémes dans Calc, et ils ne peuvent pas étre modifiés.
Cependant, vous pouvez modifier leurs styles une fois que vous les aurez appliqués a un classeur.
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Pour appliquer un théme a un classeur :

1) Cliquez sur l'icone Sélectionner des thémes dans la barre d'outils Outils. Si cette barre
d'outils n'est pas visible, vous pouvez l'afficher en utilisant Affichage > Barres d'outils >
Outils. La boite de dialogue Sélection de théme apparait. Cette boite de dialogue liste les
themes disponibles pour tout le classeur.

Outils v x
v E b 2 X B

2) Dans la boite de dialogue Sélection de théme, sélectionnez le théme que vous voulez
appliquer au classeur. Dés que vous avez sélectionné un théme, certaines des propriétés
des styles personnalisés sont appliquées au classeur ouvert et sont immédiatement
visibles.

3) Cliquez sur OK. Si vous le souhaitez, vous pouvez alors aller dans la fenétre Styles et
formatage pour modifier certains styles (voir Chapitre 4 pour plus de détails). Ces
modifications ne changent pas le théme ; elles changent uniquement I'apparence de ce
classeur particulier.

Utiliser le formatage conditionnel

Vous pouvez paramétrer le formatage des cellules pour qu'il change selon les conditions que vous
spécifiez. Par exemple, dans un tableau de nombres, vous pouvez afficher toutes les valeurs au-
dessus de la moyenne en vert et celles en-dessous de la moyenne en rouge.

Not Pour appliquer un formatage conditionnel, Calculer automatiquement doit étre
Lz activé. Choisissez Outils > Contenu des cellules > Calculer automatiquement.

Le formatage conditionnel est lié a I'utilisation des styles. Si vous n'étes pas familier des styles,
référez-vous au Chapitre 4. Une maniére facile de paramétrer les styles voulus est de formater une
cellule comme vous le voulez et cliquer sur I'icbne Nouveau style a partir de la sélection dans la
fenétre Styles et formatage.

Une fois les styles paramétrés, voici comment les utiliser :

1) Dans votre classeur, sélectionnez les cellules auxquelles vous voulez appliquer un
formatage conditionnel.

2) Choisissez Format > Formatage conditionnel > Formatage conditionnel dans la barre
de menus. La boite de dialogue Formatage conditionnel s'ouvre et affiche la liste des
conditions déja définies.

3) Cliquez sur Ajouter et saisissez la condition. Répétez cette étape autant que nécessaire.

4) Cliquez sur OK pour enregistrer. Les cellules sélectionnées sont désormais formatées
dans le style correspondant.

Depuis Calc 3.5, avec le bouton Ajouter, vous pouvez ajouter autant de conditions que vous
voulez pour votre formatage conditionnel. La Figure 26 illustre un formatage comportant trois
conditions.

Reportez-vous a I'Aide pour plus d'informations et des exemples d'utilisation.
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Formatage selon la valeur de la cellule

Vous pouvez définir une condition portant sur la valeur d'une cellule en choisissant, dans le
premier champ de définition de la condition, La valeur de la cellule est. La condition se définit alors

comme Figure 26.

Formatage conditionnel pour B4 @
1 La valeur de cellule est <=
2
La valeur de la cellule est |Z|| |5upérieurn:|u égal & |E|| 10
Appliquer le style |Haut |E|| Arial
Condition3 La valeur de cellule est entre
Ljouter | | Supprimer
oK | | Annuler

Figure 26 : Boite de dialogue Formatage conditionnel selon la valeur de la cellule
Pour chacune des conditions, vous pouvez saisir :

Condition de valeur
Choisissez des conditions comme inférieur a, supérieur a, entre parmi d'autres.

Champ paramétre
Saisissez une référence, une valeur ou une formule dans le champ paramétre, ou dans les

deux champs paramétres si vous avez choisi une condition qui nécessite deux parametres.
Vous pouvez également saisir des formules contenant des références relatives ou absolues.
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Style de cellule
Choisissez le style de cellule & appliquer si la condition spécifiée est remplie. Un apercu du
style choisi est alors visible. Vous pouvez définir un nouveau style en choisissant Nouveau
style dans la liste déroulante. La boite de dialogue Style de cellule est alors ouverte.

Formatage selon une formule

Vous pouvez définir une condition portant sur I'état Vrai ou Faux d'une formule en choisissant,
dans le premier champ de définition de la condition, La formule est. La condition se définit alors
comme Figure 27.

La formule est IZ” Bi=4

Appliquer le style ||335 IE” 1

Figure 27 : Boite de dialogue Formatage conditionnel selon une formule
Pour chacune des conditions, vous pouvez saisir :

Champ parameétre
Saisissez la formule a tester dans le champ paramétre. Si cette formule renvoie la valeur Vrai,
le formatage sera appliqué. Vous pouvez saisir des formules contenant des références
relatives ou absolues.

Style de cellule
Choisissez le style de cellule a appliquer si la formule est Vrai. Un apercu du style choisi est
alors visible. Vous pouvez définir un nouveau style en choisissant Nouveau style dans la liste
déroulante. La boite de dialogue Style de cellule est alors ouverte.

Formatage d'une plage de cellules avec une échelle de couleurs

Vous pouvez définir une condition portant sur une plage de cellules pour produire une échelle de
couleurs en choisissant, dans le premier champ de définition de la condition, Toutes les cellules,
et, dans le deuxiéme, Echelle de couleurs (2 entrées) ou Echelle de couleurs (3 entrées). La
condition se définit alors comme Figure 28.

1

|Tnute5|e5 cellules IE" |Echel|e de couleur (2 entrées) IZ”

i B

|. Rouge clair IZH |. WVert IZH

Figure 28 : Boite de dialogue Formatage conditionnel pour une échelle de couleurs
(2 entrées)
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Le résultat est semblable a celui de la Figure 29.

Figure 29 : Echelle de couleurs (2 entrées)

Formatage d'une plage de cellules avec une barre de données

Vous pouvez définir une condition portant sur une plage de cellules pour produire une barre de
données en choisissant, dans le premier champ de définition de la condition, Toutes les cellules,
et, dans le deuxiéme, Barre de données. La condition se définit alors comme Figure 30.

1

|T|:|utesle5 cellules |E|| |Barre de données |z||

|I"u'1ir1 |E|| |Ma:< |Z||

Figure 30 : Boite de dialogue Formatage conditionnel pour une barre de données

Le résultat est alors semblable a celui de la Figure 31.

e B R = Ry R & Q=N

Figure 31 : Barre de données

Gestion des formatages conditionnels
Pour appliquer ensuite le méme formatage conditionnel dans d'autres cellules :

1) Sélectionnez I'une des cellules ou le formatage conditionnel a été appliqué.
2) Copiez la cellule dans le presse-papier.
3) Sélectionnez les cellules que vous voulez voir formatées de la méme facgon.
4) Choisissez Edition > Collage Spécial.
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5) Dans la boite de dialogue Collage spécial, dans la zone Sélection, cochez uniquement
l'option Formats. Assurez-vous que les autres options ne sont pas cochées. Cliquez sur
OK.

Vous pouvez voir I'ensemble des formatages conditionnels définis dans votre feuille en choisissant
Format > Formatage conditionnel > Gérer dans la barre de menus. La boite de dialogue Gérer
le formatage conditionnel s'ouvre, comme Figure 32. Vous pouvez a cet endroit éditer un
formatage ou le supprimer.

Gérer le formatage conditionnel @
Plage | Premiére condition |
B4 )

D3:08 Echelle de couleur
F3:F8 Barre de données
Editer.. | | Supprimer
Ok | | Annuler

Figure 32 : Boite de dialogue Gérer le formatage conditionnel

Masquer et afficher les données

Quand des éléments sont masqués, ils ne sont ni visibles, ni imprimables, mais ils peuvent
toujours étre sélectionnés pour une copie si vous sélectionnez les éléments autour d'eux. Par
exemple, sila colonne B est masquée, elle est copiée si vous sélectionnez les colonnes A et C.
Quand vous avez a nouveau besoin d'un élément masqué, vous pouvez inverser le processus et
afficher I'élément.

Pour masquer ou afficher les feuilles, les lignes ou les colonnes, utilisez les options du menu
Format ou du menu contextuel (clic droit). Par exemple, pour masquer une ligne, sélectionnez tout
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d'abord la ligne et choisissez ensuite Format > Ligne > Masquer (ou faites un clic droit sur I'en-
téte et choisissez Masquer).

Pour masquer ou afficher des cellules, sélectionnez-les et choisissez Format > Cellules dans la
barre de menus (ou faites un clic droit et choisissez Formater les cellules). Dans la boite de
dialogue Formater les cellules, allez a I'onglet Protection de cellule. Le masquage ne sera effectif
qu'apres avoir protégé la feuille par Outils > Protéger le document > Feuille.

Protection de cellule

Protection

Pour activer la protection d'une cellule, vous devez
protéger la feuille active.

| Protége

Choisissez 'Protection’ dans le menu 'Outils' puis la

Masquer les formules -
commande 'Feuille'.

Irnprimer

Masquer pour I'impression Les cellules sélecticnnées ne seront pas imprimees.

Figure 33 : Masquer ou afficher des cellules

Plans et groupes

Si vous masquez et affichez sans cesse les mémes lignes ou colonnes, vous pouvez simplifier
cette tache en créant des groupes de lignes ou de colonnes, ce qui ajoute un ensemble de
contrdles de plan pour masquer ou afficher les cellules d'un groupe qui sont faciles a utiliser et
toujours disponibles.

Si la plage de cellules sélectionnée comporte des formules et si le contenu des cellules suit un
schéma régulier, comme quatre cellules suivies d'un total, vous pouvez utiliser Données > Plan et
groupe > AutoPlan pour que Calc ajoute des contrdles de plan selon le schéma. Sinon, vous
pouvez faire un regroupement manuel en sélectionnant les cellules a grouper, puis en choisissant
Données > Plan et groupe > Grouper ou en appuyant sur F12. Si vous n‘avez pas sélectionné
de lignes ou de colonnes, la boite de dialogue Grouper apparait et vous pouvez choisir de grouper
les cellules sélectionnées en lignes ou en colonnes.

Apres avoir fermé la boite de dialogue, les contréles de plan sont visibles entre les en-tétes soit de
lignes, soit de colonnes, et les bords de la fenétre courante. Les contréles de plan ressemblent a la
structure arborescente d'un gestionnaire de fichiers, et peuvent étre fermés en sélectionnant
Données > Plan et groupe > Masquer les détails. lIs sont réservés a un usage a I'écran et ne
s'impriment pas.

Les contr6les de plan de base ont des signes plus ou moins au début d'un groupe pour afficher ou
masquer des cellules. De plus, si les groupes sont imbriqués, les contréles de plan comprennent
des boutons avec des numéros pour masquer les différents niveaux.

Si vous n'avez plus besoin d'un groupe, placez le curseur de la souris dans l'une de ses cellules et
sélectionnez Données > Plan et groupe > Dissocier ou appuyez sur Ctrl+F12. Pour supprimer
tous les groupes d'une feuille, sélectionnez Données > Plan et groupe > Supprimer.
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Figure 34 : Contréles de plan

Filtrer quelles cellules sont visibles

Un filtre est une liste de conditions que chaque saisie doit remplir pour étre affichée. Vous pouvez
utiliser trois types de filtres dans le sous-menu Données > Filtre.

Autofiltres

Les Autofiltres ajoutent une liste déroulante a la ligne la plus haute d'une colonne, liste qui contient
les filtres les plus couramment utilisés. lls sont rapides, pratiques et aussi utiles pour les textes que
pour les nombres, car la liste comprend chaque valeur unique dans les cellules sélectionnées.

En plus de ces valeurs uniques, les filtres automatiques comprennent des options pour afficher
toutes les valeurs, les 10 valeurs numériques les plus fortes, les valeurs vides ou non vides.
Cependant, ils sont quelque part limités. En particulier, ils ne permettent pas l'usage des
expressions réguliéres, et donc vous ne pouvez pas les utiliser pour afficher des contenus de
cellules qui sont similaires, mais pas identiques. En revanche, ils permettent d'accéder directement
au filtre standard que vous pouvez personnaliser pour cela (voir ci-dessous).

Exemple simple d'utilisation :

B C D E
Ventes | Catégorie | Région | Employé |
2 | 20120120 2 422 42 € Golf nord Estelle
~ 3 | 03012012 5 396,85 € Tennis ouest Eric
4 | 04012012 1 707,86 € Equitation est Eric
5 | 0W01/2012 2 24145 € Golf sud Yves
6 | 07012012 915,68 € Tennis est Sophie
7 | 08/01/2012 396,00 € Equitation | sud Yves
8 | 08/01/2012 1 011,36 € Golf est Sophie
9 | 09012012 466,02 € Tennis ouest Sophie
_ 10 | 14/01/2012 1 567,86 € Equitation  est Eric
11| 15/01/2012 278,31 € Golf sud Yyes
C12 | 15/01/20120 1130,42 € Tennis est Estelle
13

Figure 35 : Liste a filtrer

1) Cliguez dans l'une des cellules de la liste, ou sélectionnez la plage de cellules (A1:E12 ici).
2) Sélectionnez Données > Filtre > AutoFiltre dans la barre de menus.
3) Des listes déroulantes apparaissent au sommet de chaque colonne.
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4) Cliguez sur la fleche en haut de la colonne Employé e

t sélectionnez toutes les lignes de

I'employé Yves en cliquant sur cette valeur dans la liste, puis en cliquant sur l'icbne
Afficher uniquement I'élément actif (voir Figure 36).

E | F G

Tri croissant

Tri décroissant
Top10
Vide

Mon vide

Filtre standard...

Eric

Estelle

Sophie
il ved

Tout = _‘§“

QK | | Annuler |

B | ¢ | b |
[ Date [~] Ventes [~] Catégori~] Région [~]Employé[~]
2 02/01/2012) 2 422 42 € Golf nord
"3 | 030112012 5 396,85 € Tennis ouest
4 0470172012 1 707,86 € Equitation est
"5 | 07/01/2012 224145 € Golf sud
6 | 07/01/2012 915,68 € Tennis est
1 08/01/2012 396,00 € Equitation sud
& | 08/01/2012 1 011,36 € Golf est
9 | 09/01/2012 466,02 € Tennis ouest
10 | 1470172012 1 667.86 € Equitation est
11 15/01/2012 278,31 € Golf sud
12 | 1500112012 113042 € Tennis est
13
14 |
15 |
_16 |
_17
_18 |
_18 |
_20 |
21
22 |
il
_24 |
_25

Figure 36 : Sélection de I'employé Yves
5) La liste est filtrée et n'affiche que les lignes avec cette

valeur. Les numéros des lignes qui

correspondent sont affichés et les numéros des autres lignes sont masqués. La fleche en
haut de la colonne choisie pour filtrer les données change de couleur et comporte un

indicateur dans son coin inférieur droit (Figure 37).

Figure 37 : Lignes filtrées et fleche modifiée

. '8 Date [~] Ventes [~] Catégor{~] Région [*]Emplo
07/01/20127 2 241 45 € Golf sud
08/01/2012 396,00 € Equitation  sud

15/01/2012  278.31 € Golf sud

)
Yves
Yves

Yves

6) Vous pouvez alors filtrer les données par Catégorie, pour n'afficher que les ventes d'articles
de golf, selon la méme méthode que ci-dessus. La fléche en haut de la colonne indique

également qu'elle est utilisée dans le filtre (Figure 38).
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| Date |~] Ventes |~]| Caté

)
L

5 07/01/2012 2 241 45 € Golf d Yves
11 | 15/01/2012 278,31 € Golf sud Yves
13

Figure 38 : Résultat de la sélection de la Catégorie Golf

Les filtres peuvent étre supprimés individuellement ou globalement.

* Pour supprimer tous les filtres, cliquez dans l'une des cellules de la liste, ou sélectionnez la
plage de cellules. Depuis la barre de menus, sélectionnez Données > Filtre > Supprimer
le filtre. Les données reviennent a I'état non filtré.

* Pour supprimer le filtre d'une colonne, cliquez sur la fleche en haut de cette colonne, puis
cochez Tout et cliquez sur OK.

Filtres standard

Les filtres standard sont plus complexes que les filtres automatiques. Vous pouvez paramétrer
jusqu'a huit conditions dans un filtre, en les combinant avec les opérateurs ET et OU. Les filtres
standard sont plus utiles pour les nombres, bien que quelques opérateurs conditionnels comme =
et <> (différent) puissent également étre utilisés pour les textes.

D'autres opérateurs conditionnels pour les filtres standard comprennent des options pour afficher
les plus grandes ou les plus petites valeurs, ou un pourcentage d'entre elles. Utiles en eux-
meémes, les filtres standard sont également intéressants pour affiner des filtres automatiques.

Pour obtenir le méme résultat que pour les Autofiltres & partir des données de la Figure 35, vous
pouvez définir un filtre standard de la fagon suivante.

Filtre standard @

Critéres de filtre

Opérateur Mom de champ Condition Valeur

|Er‘r1p||:uj,ré IZH |: IE" Ywes |Z|
ET [~] |catégorie ] |- [~] | Golf |

|-:- cun | |_ |
| | = dauiu L= b ||— | -

m|

m
1

| Plus d'options ¥ | | Aide | [ oK l| Annuler

Figure 39 : Filtre standard

Filtres spéciaux
Les filtres spéciaux ont une structure identique aux filtres standard. Limités également a huit

conditions (en-tétes inclus), leurs criteres ne sont pas saisis dans une boite de dialogue mais
directement dans le classeur.

Pour filtrer les données de la Figure 35 de la méme fagon que ci-dessus :

1) Copiez les en-tétes de données dans une partie vide de la feuille.

2) Dans les cellules en dessous, insérez les données qui vont servir de filtre.

3) Pour que les filtres soient reliés par un ET, saisissez les données sous les en-tétes
correspondants et sur la méme ligne. Pour gu'ils soient reliés par un OU, saisissez les données
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sur des lignes différentes.

H s J | K | L |

Date Ventes Catégorie Région Employé
Golf Ywes

Figure 40 : Deux valeurs de filtre reliées par ET

4) Cliguez dans l'une des cellules de la liste, ou sélectionnez la plage de cellules.
5) Sélectionnez Données > Filtre > Filtre spécial. La boite de dialogue Filtre spécial s'ouvre.

6) Sélectionnez les données du filtre spécial. Si vous les sélectionnez avec la souris, H1:L2
dans l'exemple, durant leur sélection, elles sont entourées en rouge. Une fois la sélection
effectuée, les données sont entourées en bleu et la boite de dialogue contient la référence
absolue a ces données (). Vous pouvez également saisir directement la référence des
données du filtre spécial, ici H1: L2.

F | G H | I | J | K | L M
Date Ventes Catégorie Région Employé
Golf Yyes
Filtre spécial (5]
Lire les critéres de filtre dans

[ 0K |

- indéfini - [v| Eventes2sHs1:5L52 &
| Annuler |
| Aide |
| Blus ¥+ |

Figure 41 : Filtre spécial
7) Cliquez sur OK.
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Trier des enregistrements

Le tri modifie la disposition des cellules visibles dans la feuille. Dans Calc, vous pouvez utiliser
simultanément jusqu'a trois critéres de tri, qui sont appliqués I'un aprés l'autre. Les tris sont
pratiques quand vous cherchez un élément particulier, et sont encore plus puissants combinés aux
filtres.

De plus, le tri est souvent utile quand vous ajoutez de nouvelles données. Quand une liste est
longue, il est habituellement plus facile d'ajouter des données en bas de la feuille, plutét que
d'insérer des lignes a leur bonne place. Apres avoir ajouté des données, vous pouvez les trier pour
mettre & jour la feuille.

Si les données sont disposées en colonne et comportent un en-téte au format texte, An 2
vous pouvez utiliser le tri rapide. Pour ceci, mettez en surbrillance les cellules a trier, a& n‘g’
puis cliquez sur les boutons de barre d'outils Tri croissant ou Tri décroissant. Vous

pouvez également, si un Autofiltre est défini, utiliser Tri croissant ou Tri décroissant accessibles
a partir de la fleche en haut de la colonne que vous désirez.

D | E | F | G
Région [~]Employé[~]
nord Tri croissant
ouest Tri décroissant
est
sud Top 10
est Vide
sud

Mon vide

Figure 42 : Tri a partir de I'Autofiltre

Pour un tri plus élaboré, mettez en surbrillance les cellules a trier, puis sélectionnez Données >
Trier pour ouvrir la boite de dialogue Tri (Figure 43). Dans la boite de dialogue, vous pouvez trier
les cellules sélectionnées, dans l'ordre croissant (A-Z, 1-9) ou dans l'ordre décroissant (Z-A, 9-1).

(Nouveauté Calc 3.6) Le nombre de clés de tri est désormais illimité. La définition de la clé de tri 3
fait apparaitre la clé de tri 4, et ainsi de suite.

Tri ==

Critéres de tri |Gp-ticrn5|

Cledetril -
@ Croissant
|C|:|I|:|r1neA |z||
) Décroissant
Clédetri2

@ Croissant

) Décroissant
Clédetri3

- indléfini - -]

@ Croissant

m

' Décroissant

Figure 43 : Choisir les criteres et les ordres de tri
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Vous pouvez définir un ordre de tri personnalisé si les ordres alphanumériques
Astuce fournis ne vous conviennent pas. Pour ce faire, voir “Définir une série de
remplissage” page 10.

Dans l'onglet Options de la boite de dialogue Tri (Figure 44), vous pouvez choisir les options
suivantes.

Tri ==

Critéres de tri | Options

Hespecter |a casse!

La plage contient des étiquettes de colonne
| Inclure les formats

Activer le tri naturel

Copier le résultat du tri vers :

Ordre de tri personnalisé

Langue Options

Par défaut - Frangais (France) |E|

Direction
@ De haut en bas (tri de lignes)

De gauche a droite (tri de colonnes)

Figure 44 : Options de tri

Respecter la casse
Pour deux entrées par ailleurs identiques, celle avec une lettre majuscule est placée avant
celle avec une lettre minuscule dans la méme position si le tri est décroissant ; si le tri est
croissant, alors l'entrée avec une lettre majuscule est placée aprés celle avec une lettre
minuscule dans la méme position.

La plage contient des étiquettes de colonne
N'inclut pas les étiquettes de colonnes dans le tri.

Inclure les formats
Le formatage d'une cellule est déplacé avec son contenu. Si un formatage est utilisé pour
distinguer différents types de cellules, alors utilisez cette option.

Activer le tri naturel
Prend en compte les nombres préfixés par une chaine de caractéres au lieu de s'en tenir au
strict ordre alphanumérique. Vous pouvez avoir par exemple une plage de cellules contenant
Al, A2, A3, ..., A19, A20, A21. Si vous activez le tri naturel, vous obtiendrez un tri dans cet
ordre. Si vous ne l'activez pas, vous obtiendrez Al, A10, All, ..., A19, A2, A20, A21, A3, A4,
.., A9.
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Copier le résultat du tri vers
Détermine une adresse dans un classeur ou copier le résultat du tri. Vous pouvez indiquer une
référence, une plage de cellules nommée ou une plage de données.

Ordre de tri personnalisé
Sélectionnez le champ, puis choisissez dans la liste déroulante une des séries de remplissage
définies dans Outils > Options > LibreOffice Calc > Listes de tri.

Direction

Détermine si les lignes ou les colonnes sont triées. Par défaut, le tri se fait de haut en bas (tri
de lignes).

Rechercher et remplacer dans Calc

Calc propose deux fagons de rechercher du texte dans un document : la barre d'outils Rechercher
pour une recherche rapide et la boite de dialogue Rechercher & remplacer.

Utiliser la barre d'outils Rechercher

Vous pouvez afficher ou masquer la barre d'outils Rechercher en utilisant Affichage > Barres
d'outils > Rechercher, ou en appuyant sur Ctrl+F et Echap.

9 Rechercher |Z| b qp H

Tapez un terme a rechercher dans le champ Rechercher, et cliquez ensuite sur le bouton
Rechercher le suivant (fleche vers le bas) ou Rechercher le précédent (fleche vers le haut).
Pour trouver les autres occurrences de ce méme terme, continuez de cliquer sur le bouton.

Utiliser la boite de dialogue Rechercher & remplacer

Pour afficher la boite de dialogue Rechercher & remplacer (Figure 45), utilisez le raccourci clavier
Ctrl+H, choisissez Edition > Rechercher & remplacer dans la barre de menus ou sélectionnez
I'icone Rechercher&Remplacer dans la barre d'outils Rechercher.

Dans les classeurs, vous pouvez recherchez des textes, des formules et des styles. Vous pouvez
naviguer d'une occurrence a l'autre en utilisant Rechercher, ou vous pouvez mettre en surbrillance
toutes les cellules qui correspondent en une fois en utilisant Tout rechercher, puis appliquer un
autre format ou remplacer le contenu de la cellule par un autre.

Les textes et les nombres dans les cellules peuvent avoir été saisis directement ou étre le résultat
d'un calcul. La méthode de recherche que vous allez utiliser dépend du type de données que vous
recherchez.

Le contenu des cellules peut étre formaté de différentes fagons. Par exemple, un
nombre peut étre formaté en Monétaire, pour étre affiché avec le symbole de la
devise. Vous voyez le symbole monétaire dans la cellule, mais vous ne pouvez pas
le rechercher sauf s'il a été appliqué via un style (cf. page 39).

Astuce

Par défaut, Calc recherche dans la feuille courante. Pour rechercher dans toutes les feuilles d'un
document, cliquez sur Plus d'options, puis cochez Recherchez dans toutes les feuilles.
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Attention Utilisez Tout remplacer avec prudence ; sinon, vous pouvez vous retrouver avec
des erreurs trés génantes. Une erreur avec Tout remplacer peut nécessiter une
& recherche manuelle et mot par mot pour la réparer, si elle n'est pas découverte a
temps pour pouvoir I'annuler.

Rechercher & remplacer @

Rechercher

Calc |Z|

[ Bechercher l

| Tout rechercher |

Rernpl
emplacer par | Bernplacer |

| Tout remplacer |

Respecter la casse

Moins d'options & | | Aide | | Eermer

Sélection active seulement
Wers le haut

Expressicns réguliéres
Rechercher des similarités

Rechercher des styles

Bechercher dans Formules IZH

Sens de la recherche @ Lignes
Colonnes

Rechercher dans toutes les feuilles

Figure 45 : Boite de dialogue Rechercher & remplacer étendue

Rechercher et remplacer des formules ou des valeurs

Vous pouvez utiliser la boite de dialogue Rechercher & remplacer pour rechercher dans des
formules ou dans les valeurs affichées qui résultent d'un calcul.

1) Pour ouvrir la bo[te de dialogue Rechercher & remplacer, utilisez le raccourci clavier Ctrl+H
ou sélectionnez Edition > Rechercher & remplacer.

2) Cliquez sur Plus d'options pour étendre la boite de dialogue.

3) Sélectionnez Formules ou Valeurs dans la liste déroulante Rechercher dans.
. Formules examine les parties des formules.

o Valeurs examine le résultat des calculs.
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4) Tapez le texte que vous voulez rechercher dans le champ Rechercher.

5) Pour remplacer le texte par un texte différent, tapez le nouveau texte dans le champ
Remplacer par.

6) Une fois votre recherche paramétrée, cliquez sur Rechercher. Pour remplacer le texte,
cliguez a la place sur Remplacer.

Rechercher et remplacer des textes

1) Ouvrez la boite de dialogue Rechercher & remplacer, cliquez sur Plus d'options pour
étendre la boite de dialogue et sélectionnez Valeurs ou Remarques dans la liste déroulante
Rechercher dans.

2) Tapez le texte que vous voulez trouver dans le champ Rechercher.

3) Pour remplacer le texte par un texte différent, tapez le nouveau texte dans le champ
Remplacer par.

4) Cliquez sur Rechercher, Tout rechercher, Remplacer ou Tout remplacer.

Quand vous cliquez sur Rechercher, Calc sélectionne la cellule suivante qui contient votre texte.
Vous pouvez modifier le texte, puis cliquer a nouveau sur Rechercher pour avancer a la cellule
suivante trouvée. Si vous fermez la boite de dialogue, vous pouvez appuyer sur Ctrl+Maj+F pour
trouver la cellule suivante sans ouvrir la boite de dialogue.

Quand vous cliquez sur Tout rechercher, Calc sélectionne toutes les cellules qui contiennent
votre saisie. Vous pouvez alors, par exemple, appliquer un style de cellules a toutes ces cellules
en méme temps.

Rechercher et remplacer des styles de cellules
Pour modifier rapidement toutes les cellules d'un style donné (non désiré) avec un autre style
(préféré) :
1) Dans la boite de dialogue Rechercher & remplacer étendue, sélectionnez Rechercher des
styles. Les champs Rechercher et Remplacer par contiennent alors une liste de styles.
2) Sélectionnez les styles que vous voulez rechercher et remplacer.
3) Cliquez sur Rechercher, Tout rechercher, Remplacer ou Tout remplacer.

Utiliser les caractéres génériques (expressions réguliéres)

Les Caractéres génériques (ou expressions réguliéres) sont des combinaisons de caractéres qui
indiquent a LibreOffice comment rechercher quelque chose. Les expressions régulieres sont trés
puissantes, mais pas tres intuitives. Elles peuvent faire économiser du temps et du travail en
combinant de multiples recherches en une seule.

Pour utiliser les caractéres génériques et les expressions réguliéres pendant une recherche et un
remplacement :

1) Dans la boite de dialogue Rechercher & remplacer, cliquez sur Plus d'options pour avoir
plus de choix. Dans cette boite de dialogue étendue, cochez Expressions réguliéres.

2) Tapez le texte a rechercher, comprenant les caractéres génériques, dans le champ
Rechercher et le texte de remplacement (s'il y a lieu) dans le champ Remplacer par.

3) Cliquez sur Rechercher, Tout rechercher, Remplacer ou Tout remplacer (non
recommandeé).

Astuce L'aide du logiciel décrit plusieurs expressions réguliéres et leur utilisation.
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Les points suivants peuvent intéresser les utilisateurs de Calc :

Dans Calc, les expressions régulieres sont appliquées séparément a chaque cellule. Cela
signifie qu'une recherche de s.c va trouver sac dans la cellule A1, mais ne va pas trouver s
dans la cellule A2 ni ¢ (ou ac) dans la cellule A3. (L'expression réguliére s.c signifie que le
systéme va essayer de trouver s suivi de n'importe quel caractére suivi de c¢.)

Quand une correspondance est trouvée, la cellule entiere est en surbrillance, mais seul le
texte trouvé sera remplacé. Par exemple, la recherche de homme aura pour résultat de
mettre en surbrillance une cellule qui contient gentilhomme campagnard, et ne rien
choisir dans le champ Remplacer par laissera la cellule avec gentil campagnard.

Si Rechercher est utilisée deux fois a la suite, et si la seconde fois Sélection active
seulement est coché, alors la seconde recherche sera évaluée dans la totalité de chaque
cellule sélectionnée, et non uniquement dans la chaine qui a fait que la cellule soit
sélectionnée par la premiére recherche. Par exemple, la recherche de joh?n, puis
I'activation de Sélection active seulement et la recherche de sm.th va trouver les cellules
contenant John Smith et Smythers, Johnathon.

Si une cellule contient un saut de ligne manuel (entré par Ctrl+Entrée), il peut étre trouvé
en utilisant I'expression réguliére \n. Par exemple, si une cellule contient mur[saut de
ligne]porteur, une recherche de r\np sans rien dans le champ Remplacer par laissera la
cellule avec muorteur.

Le saut de ligne manuel agit également pour marguer une “fin de texte” (similaire a une “fin
de paragraphe” dans Writer), trouvé par le caractére spécial d'expression réguliere $, en
plus de la fin de texte dans une cellule. Par exemple, si une cellule contient mur[saut de
ligne]porteur, alors une recherche de r$ remplacé par et laissera la cellule avec
muet[saut de ligne]porteur. Notez qu'avec cette syntaxe, le saut de ligne n'est pas
remplacé.

L'utilisation de \n dans le champ Remplacer par va provoquer un remplacement par les
caractéeres \n, et non par un saut de ligne.

La boite de dialogue Rechercher & remplacer a une option qui permet de rechercher dans
des formules, des valeurs ou des remarques (pour rechercher dans les commentaires).
Cette option s'applique a toutes les recherches, et non pas uniqguement celles avec des
expressions réguliéres. Une recherche de SOM avec I'option Formules va trouver une
cellule contenant la formule =SOMME(A1:A6), ainsi qu'une cellule contenant le texte
simple SOMMAIRE.

Une recherche de l'expression réguliere A$ ne va pas trouver les cellules vides. C'est
intentionnel, pour éviter les problémes de performance quand on sélectionne un grand
nombre de cellules. Notez que les cellules vides ne seront également pas trouvées si vous
faites une recherche dans la sélection active seulement.

Le fait de trouver les contenus de cellules en utilisant I'expression réguliére .+ (ou similaire)
et de les remplacer par & va en pratique ressaisir le contenu des cellules sans formatage.
Cette technique peut étre utile pour supprimer le formatage automatiquement appliqué par
Calc lors de I'importation de données depuis le presse-papier ou un fichier mal formaté.
Par exemple, pour convertir les textes constitués de chiffres en nombres, formatez tout
d'abord les cellules en nombres et faites ensuite la recherche et le remplacement.

Voir Chapitre 7 (Formules et Fonctions) pour l'utilisation des expressions réguliéres dans les
formules.
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